Planning and Scheduling of Commercial Project Using Advanced Management Software

T. Venkadesan	extsuperscript{1,*}, M. M. Vishnu Priya	extsuperscript{2}, S. Suganya	extsuperscript{3}

	extsuperscript{1,*}Associate Professor, PRIME College of Architecture and Planning, Kilvelur, Nagappatinam District, Tamil Nadu

	extsuperscript{2,3}Assistant Professor, PRIME College of Architecture and Planning, Kilvelur, Nagappatinam District, Tamil Nadu

Abstract: In the rapid development of construction industries are seeks in planning and scheduling to execute the project. So my concentration and platform I lay down in planning and scheduling by using the software Primavera and making use to develop the construction industries. The software is used to predetermine the execution process and mitigate the immediate lacks in the project. It helps to analysis and make fast in construction and find out the critical path of the project.

Index Terms: Construction management, Primavera, planning, scheduling, commercial building, Preproject planning, management software.

Project management is the art and science of mobilizing and managing people; materials, equipment and money to complete the assigned project work in time within the budgeted costs and with the specified technical standards. It aims at achieving the specified objectives efficiently and effectively by managing human energies and optimizing the non-human resources placed at their disposal.

1 INTRODUCTION

Project involves much kind of jobs, activity and functions. They are interrelated. A project starts and end time at specific moment. It requires labour, material and equipment. The effective handlings of these enable the project to be completed economically and quickly maintain standards. It should resulting unique product or services.

2 PROJECT MANAGEMENT

Project management is the art and science of mobilizing and managing people, materials, equipment and money to complete the assigned project work on time within the budgeted costs and specified technical standards.

It aims at achieving the specified objectives efficient by managing human energies and optimizing the non human resources placed at their disposal.

3 NEED FOR PROJECT MANAGEMENT:

The merit of a project depends mainly upon its cost and use. It requires the resources like manpower, materials, equipment and finance. The availability of the above resources is limited and uncertain. Hence, they must be utilized in a planned and efficient manner to derive maximum benefits, unexpected site conditions, machinery breakdown, shortage of materials and non-availability of labour may delay that the progress.

Modern projects are complex. They involve many kinds of administrative skills and technology. They demand through planning and wide knowledge of laws, rules and regulations. They enable the project to be completed within a reasonable time at a fairly economical cost without detrimental to the standards of construction.

Each project is to be divided into a number of stages of works. The requirements of resources for each stage are worked out. The sequences of stages are logically arranged. Good relationship between the employers and employees should be considered. Speedy execution with effective control of quality should be maintained. A good knowledge of labour relations and safety practices are essential. Application of latest management techniques ensures a smooth flow of men and materials to effect speed and economy of construction. Hence, management is needed to enhance the effective handling of resources so as to derive the maximum benefit.
Despite diversities and multifarious activities, each project is an entity in itself. It is organized to achieve its mission, within predetermined objectives. Its accomplishment is entrusted to a single responsibility centre, commanded by the project manager.

The project manager aims at achieving the following project mission.

- Within the project time, cost and quality.
- By planning, organizing, coordinating, monitoring and controlling the available resources.
- Managing the organizational behavior with the assistance of the project team and the specialists.

5 PROJECT MANAGEMENT FUNCTIONS

The overall aim of the management in an enterprise is to create within the enterprise, an environment that will facilitate the accomplishment of its objectives. In doing, this management has to perform certain functions. Although the development of a theory and science of management suffers from disagreement among scholars and managers, a general pattern of functions which management has to perform, has emerged. Traditionally, management functions are grouped under eight headings, namely planning, scheduling, organizing, staffing, directing, monitoring and controlling common to these functions is the function of coordination.

The functional areas, with some adjustments on account of the special characteristics of construction projects, are equally applicable in project management. The project management functions of planning, scheduling, organizing procuring, leading, monitoring and controlling are as follows:

5.1 PLANNING

Planning involves deciding in advance what is to be done, how and what order it is to be done in order to achieve the objectives. Planning aims at deciding upon the future course of action. A plan shows the committed course of action. Schedule depicts when the planned activities are to be carried, it puts the plan on calendar date scale.

In brief, planning and scheduling involves the following:

- Crystallizing objectives.
- Collecting and synthesizing information.
- Developing alternative courses of action within the specified constraints.
- Comparing alternatives in terms of objectives feasibility and consequences
- Selecting and scheduling the optimum course of action.
- Establishing policies, procedures, methods, schedules, programs, systems standards and budgets for accomplishing project objectives.

5.2 SCHEDULING

Scheduling means putting the plan on calendar basis. A project network shows the sequence and interdependencies of activities, their time durations and their earliest and latest completion time, but this needs to be scheduled to determine commencement and termination dates of each activity, using optimum resources or working within resource constraints. A time schedule outlines the project work programme, it is a timetable of work. A Schedule is a work programme, set data-wise in a logical sequence; it is a timetable of action. Time scheduling is the process of developing a work programme.

5.3 ORGANIZING

Organizing is the process of establishing a structural relationship among functions of people, so as to formulate effective machinery for streamlining the achievement of assigned objectives. Organizing involves the following main tasks:

- Dividing the work into component activities.
- Designing job structures.
5.4 PROCURING
It implies managing and keeping man power, the positions created by organization structure and providing them the right quality resources at the right time. The resources include people, materials, machinery and money. The connected project management tasks include the following:
- Preparing resources procurement schedules.
- Developing specifications for required resources.
- Deciding appropriate sources of procurement.
- Budgeting resources and arranging approvals and purchases.
- Preventing wastage during resource holding at site.
- Supplying on time required quantity and quality of resources to project construction sites.

5.5 DIRECTING (OR) LEADING
It involves influencing people so as to enable them to contribute the goals efficiently and effectively. Direction implies the following tasks:
- Providing effective leadership.
- Motivating participant’s behaviors.
- Communicating instructions and orders properly.
- Providing a suitable climate for subordinates development.

5.6 MONITORING
The performance monitoring process commences after the monitor receives the appropriate performance data through site reports, personal visits and discussions. The performance monitoring process consists of:
- Consolidating reported performance data.
- Analyzing performance variances.
- Forecasting performance trends.

5.7 CONTROLLING
Controlling involves monitoring of the performance and applying corrective measures in case of deviations from the plan. The process of control can be sub-divided into the following stages:
- Specifying the factors to be controlled.
- Stating the methods of measuring control factors
- Evolving systems for generating performance data
- Monitoring data received and formulating corrective options.
- Applying corrective measures to put a plan on the scheduled path.

6 BRIEF OVERVIEW OF LITERATURE
Matthew J. Libratore, Colleen A. Smith, (2001) “Project Management In Construction: Software Use And Research Directions” were described the future research and use of project management software in construction industry. The software package of choice among most construction respondents is primavera, which contrasts with total respondents’ heavy use of Microsoft project. The results also indicate those construction professionals who use, more analytical techniques tends to choose the full featured software package primavera over other packages, while those who use fewer techniques chose the more basic Microsoft project packages.

Leen S.Kang, C.Park And Bac H.Lee, (2001) “Optimal Schedule Planning For Multiple, Repetitive Construction Process” was concluded that the construction schedule model using a conceptual approach to improve the efficiency of construction process (MRCP). It is important for a project manager to arrange the number of horizontal repetitive work areas by each crew group to reduce the work interruption period in MRCP. A computer program developed for the analysis of MRCP. Earlier change the project completion date and cost loss also greatly reduced.

Feniosky Pena-Mora And Michael, (2001)“Dynamic Planning And Control Methodology For Design/Build Fast-Track Construction Projects” suggested that the dynamic planning and control methodology
developed by integrated the application of axiomatic design concepts, the graphical evaluation and review technique (GERT), concurrent engineering concepts and the system dynamics modeling technique. The goal of the proposed methodology is to help create a dynamic project plan for design/building fast-track civil engineering and architectural projects where unforeseen changes can be absorbed in the project schedule without creating major interruptions. The overall increase in productivity and efficient as a result of a better planning process can consequently promote the competitiveness of construction industry.

Jacob, Lynn Crawford, Segun Faniran, (2000) “Strategic Planning Practices In Construction Firms” were concluded how strategic planning is actually conducted in construction firms and roles played by the different level of management. The strategic planning in construction firms consists of defining corporate objectives, implementation, strategic plan, monitoring plan during implementation and review where necessary. Profit, customer satisfaction and quality were found to be the three most significant corporate objectives of construction companies. Furthermore customer relations were found to be the most significant practice factor is achieved by the successful strategic planning.

Christope Midler, Gilles Garel, (2000) “Causes In Construction Delays” says control of time and cost are two important tasks in the field of project management. Controlling the project to minimum time and cost are contractor’s prime objective. Time relates to cost, as shorter duration should reduce the cost of jobsite overhead on the project. Time and cost control are however normally separate tasks on the jobsite. This paper outlines the project cost control system for controlling a time bound, capital intensive and high cost construction project. It introduces the cost documentation procedures for achieving the specified objective.

Dora Cohenca, Alexander Laufer, (1989) “Factors Affecting Construction Planning Efforts” were concluded that environmental uncertainty strongly the construction environment is very uncertain. The finding presented clearly shows that when going from average to complex uncertainty situations, planning efforts should be adjusted to meet the changed conditions. Result of this study suggests that construction firms must adjust their planning to variable situations.

7 SCOPE AND OBJECTIVES

- To prepare the plan based on calendar date scale.
- To prepare a schedule based on resource constraint.
- To find the variance analysis, resource analysis and resource leveling, report generation effectively based on the project.
- To implement the above in primavera software.

8 ADVANCE MANAGEMENT SOFTWARE

The Advanced management software is used to predetermine the execution process and mitigate the immediate lacks in the project. It is used to do the variance analysis, resource analysis and resource leveling, report generation effectively. It is also used to identify profit or loss and make fast in construction and find out the critical path of the project.

9 PRIMAVERA PROJECT PLANNER (P3)

Primavera is the project management tool. It can be called as P3 (primavera project planner). P3 is the product from primavera system corporation from Pennsylvania, USA. Founders are Mr. Richard Kopp and Mr. Four’s.

P3 can schedule and manage up to 1, 00,000 activities effectively.

Unlimited number of resource variance analysis (demand) and leveling (balancing). Report generation can be done effectively. Profit (or) loss identification; resource requirement and demand are calculated in the software effectively.

9.1 CREATING A NEW PROJECT

In primavera project planner File  New is to be selected to create a new project.

This command is used to add a new project, and to specify basic project information such as planning unit, the no of workdays per week, the project start and finish dates and setting defaults such as folder location to save the project, and to specify the project name and company name.

A resource can be defined as something that is assigned to an activity and is required to accomplish the task. The resource includes people, materials, equipment and money. It is recommended that create and assign the minimum number of resources to activities.

Once project schedule is ready with the activities, duration, start and finish dates for each activity and for the whole projects, next work is defining and assigns resource to the activities.
9.2 CALENDARS

After adding activities and their duration, calendars are defined for the activities. All activities in P3 are assigned to a calendar that defines when works on the activity can occur. P3 requires all durations within a project group be entered using the same planning unit which was defined in the Add a new project form when the project was created.

The planning unit can be any one of the following:
- Hours
- Days
- Weeks
- Months

9.2.1 DAY CALENDAR

For defining calendar Data → Calendars is to be selected

The majority of projects are scheduled using day calendar. Generally daily project global calendars are used to include public holidays. Public holidays on the same date every year should be made repeating, so that they appear every year. Holidays given in the global calendar are reflected in each base calendar.

9.2.2 HOUR CALENDAR

Hour calendar work is a similar way to the day calendar but have an additional option of specifying working hours. In addition to the day calendar, on the right hand side in the dialog box shows the hour setting. By default it shows 24 hours working.
9.2.3 WEEKLY CALENDAR

In weekly calendars, all weeks are available for work. The smallest unit of time in a weekly calendar is one week. In a week calendar if select a day of the week, the whole week is selected.

9.2.4 MONTHLY CALENDARS

In monthly calendars, all months are available for work. The smallest unit of time in a monthly calendar is one month in a monthly calendar. The monthly calendar is similar to weekly calendar.
In weekly and month calendars, all weeks and months are available for work unless specify otherwise by defining non-work period. The smallest unit of time in a weekly calendar is one week and one month in a monthly calendar.

9.3 ACTIVITY CODES

Activity codes are used to sort, select, summaries and group activities under various headings. P3 offers a set of standard activity codes for every new project including location, phase, milestone and others. Activity code dictionary is used to define additional codes for the project.

The activity code dictionaries are created for each project and the activity code values are assigned to reflect the items within the break down structure. Activity code values are assigned to each activity so activities can be grouped and sorted.

9.3.1 DEFINING ACTIVITY CODES

To define activity codes for the project select Data, Activity Codes and is selected the activity codes tab is clicked.

The tabs in the dialog box, activity ID and alias enable to codes, values and title for activity codes, activity ID codes, and aliases. An activity code has a name and description. The dictionary holds a series of values and each value has a description.

9.3.2 ASSIGNING ACTIVITY CODES

Activity codes are assigned to activities before activities be grouped under their respective codes. This enables the activities to be grouped and presented under different headings. Resources And Cost Analysis whole projects, next work are defining and assign resource to the activities.
9.3 WORK BREAKDOWN STRUCTURE (WBS)

After the scope of planning for a project is done we need to create a work breakdown structure (WBS) to define and organize the project elements. So that clearly identifies the deliverable and summaries schedule and cost data at different levels of details are must. A WBS represents a historical breakdown of a project into elements.

9.3.1 DEFINING THE WBS STRUCTURE

To define the WBS for the project structure Data ➔ WBS is selected. Defining the WBS codes have to build the code dictionary to describe the level and to define the WBS structure in hierarchical manner.

9.3.2 ASSIGNING THE WBS STRUCTURE

WBS structure are assigned to activities before activities be grouped under their respective work breakdown structure. This enables the activities to be grouped and presented under different headings.

9.4 RESOURCES AND COST ANALYSIS

A resource can be defined as something that is assigned to an activity and is required to accomplish the task. The resource includes people, materials, equipment and money. It is recommended that create and assign the minimum number of resources to activities.

Once project schedule is ready with the activities, duration, start and finish dates for each activity and for the whole projects, next work is defining and assigns resource to the activities.

9.4.1 DEFINING THE RESOURCES

To define the resource for the project Data ➔ Resources is selected.
All the resources (people, material, equipment) are defined to use in the project in the resource dictionary. Then the appropriate resources, costs to each activity are allocated. Normal and maximum limits of resources are also defined.

9.4.2 ASSIGNING RESOURCES USING RESOURCE FORM

To assigning the resource for the project View ➤ Activity Form ➤ Resources is selected.

Assign all the resources (people, material, equipment) to use in the project in the resource form. Then allocate the appropriate budgeted quantity of resources and Mark the driving material in the project.

9.5 ESTIMATING COST FOR THE PROJECT

After the resource assigning P3 automatically calculate the budgeted cost of the each activity and entire project. The assigned resources and resources based budgeted cost of the activities appeared in the data column (or) entry sheet.
Managing large and complex projects is one of the biggest challenges that companies faces nowadays. One of the core challenges in large scale projects in the construction industry is maintaining adequate transparency in to project progress and updating and tracking huge data base software like primavera is born to project management professionals, which aid them in administration, project management and tracking.

The proposed project is the construction of commercial complex. The project completion takes 206 working calendar days. The project also takes capital-intensives, heavy equipment oriented works that involves movement of large quantity of bulk inventories like earth, steel and concrete. So the project stimulation is carried out using primavera (P3) software.

10.1 ACTIVITY CODE BASED SCHEDULING

In the activity code based scheduling, activity codes are used to sort, select, summaries and group under various heading. Activity codes are assigned to each activity. So activities can be grouped and sorted by the P3 software effectively.

10.2 WORK BREAK DOWN STRUCTURE BASED SCHEDULING

After the scope planning for the project is done, a work breakdown structure (WBS) is used to define and organize the project elements. A WBS represents a hierarchical breakdown of a project in to elements. So that it can clearly identify, summarize schedule and cost data at different level of project.

10.3 SUMMARY

Primavera, it is an ideal choice for project management professionals to continuously maintaining productivity and profitability. So the project stimulation is carried out using primavera (P3) software.

11 REFERENCES


